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Abstract

GAIA (Graphical Astronomy and Image Analysis) is an interactive astronomical image display
and analysis tool. It includes a comprehensive suite of facilities for displaying and manipulating
images. It also has extensive facilities for the astronomical analysis of images, including:
astrometric calibration, automatic object detection and aperture, optimal and surface photometry.
GAIA can access images in most of the data formats common in astronomy and can also retrieve
copies of remote images and catalogues via the Internet.

This cookbook is an introduction to GAIA. It describes the facilities that GAIA provides and
gives some simple examples of their use. It refers to GAIA version 2.6 or higher.

Who Should Read this Cookbook?

This cookbook is aimed at astronomers who are new to GAIA, but who think that it might be
useful in their work. It is not aimed at experienced users of GAIA, for whom the GAIA manual
(SUN/214) or the on-line help within GAIA itself might be more useful.

Copyright c© 2001 Council for the Central Laboratory of the Research Councils

http://www.starlink.ac.uk/cgi-bin/htxserver/sun214.htx/sun214.html?xref_
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1 Introduction

While the incidental scraps of theogony in Homer name Okeanos ‘Ocean’ as the
origin of the gods (theôn génesis), in Hesiod it is Earth (Gaia) who gives birth to
Heaven (Ouranos) and then marries him; they engender the Titans, among them
Okeanos and Kronos [Saturn in the Roman interpretation].

Comparative Mythology,
Jaan Puhvel, 1987.

GAIA (Graphical Astronomy and Image Analysis) is an interactive astronomical image display
and analysis tool, broadly similar to SAOIMAGE (for which see SUN/166[14]). It includes a
comprehensive suite of facilities for displaying and manipulating images (panning, zooming,
setting the colour table etc). It also has extensive facilities for the astronomical analysis of images,
including: astrometric calibration, automatic object detection and aperture, optimal and surface
photometry (see Section 3). GAIA can display two-dimensional spectra, but has no facilities for
specifically spectroscopic analyses.

GAIA can access images in most of the data formats common in astronomy, including Starlink
NDF files and FITS images (see Section 4). It can also retrieve copies of remote images and
catalogues via the Internet.

This cookbook is an introduction to GAIA. It describes the facilities that GAIA provides and
gives some simple examples of their use. It refers to GAIA version 2.6 or higher. The structure
of the cookbook is:

Part I – introduction and getting started with GAIA,

Part II – a set of recipes describing in detail how to perform some useful tasks with GAIA.

The cookbook is aimed at astronomers who are new to GAIA, but who think that it might
be useful in their work. It is complemented by the GAIA User’s Manual, SUN/214: GAIA –
Graphical Astronomy and Image Analysis Tool[8], which gives detailed information about the tool.
Experienced users of GAIA are more likely to find this latter document useful than the present
cookbook. Extensive on-line help information is also available from within GAIA itself.

1.1 GAIA and SkyCat

GAIA is a customisation and enhancement of the SkyCat1 image display tool developed by
Allan Brighton and colleagues as part of the ESO2 VLT3 project. GAIA’s basic display and remote
catalogue and archive access facilities are largely the original SkyCat. However, the facilities for
astronomical analysis, such as astrometric calibration, object detection and photometry are all
enhancements unique to GAIA. Many of these enhancements are implemented by causing GAIA
to automatically invoke conventional Starlink packages (such as PHOTOM for photometry; see
SUN/45[10]) ‘behind the scenes’. However, the user just sees seamless interaction through the
GAIA GUI (Graphical User Interface). Also, GAIA can access images in a wider range of data
formats than SkyCat (see Section 4).

1http://archive.eso.org/skycat/
2http://www.eso.org/
3http://www.eso.org/vlt/

http://www.starlink.ac.uk/cgi-bin/htxserver/sun166.htx/sun166.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun214.htx/sun214.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun214.htx/sun214.html?xref_
http://archive.eso.org/skycat/
http://www.eso.org/
http://www.eso.org/vlt/
http://www.starlink.ac.uk/cgi-bin/htxserver/sun45.htx/sun45.html?xref_
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2 Typographic Conventions

The following typographic conventions are used in this cookbook.

Anything that is to be typed into a computer program via the keyboard,
or output from one via the screen, is indicated by a ‘typewriter’ font
like this.

Lines that are to be typed into the computer are shown beginning with a % sign, for example:

% gaia

The % indicates the Unix ‘shell prompt’ and should not be typed in. However:

items appearing in GAIA’s graphical windows are shown in a sans serif font like this.
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Part I

Background Material

3 Facilities Available

This section outlines the facilities available in GAIA. The hypertext version of the cookbook
contains links to ‘outline recipes’ which summarise how to use these facilities. These outline
recipes complement the smaller number of detailed recipes in Part II of the cookbook. The
facilities provided by GAIA divide naturally into three areas:

• image display,

• image analysis,

• remote access to catalogues and image databases via the Internet.

The facilities available in each of these three areas are briefly outlined below.

3.1 Image Display

Displaying images Opening files, displaying more than one image, maximising the display
area.

Controlling the view Changing the zoom, position, detail and colours.

Inspecting image values Panel readouts, interactive slices, pixel table.

Overlay graphics Creating, resizing, moving, deleting, saving and restoring.

Printing Image and overlay graphics, colour ramp.

3.2 Image Analysis

Astrometry applying and displaying celestial coordinates to an image.

Photometry interactive measurements of selected stars using a circular or elliptical aperture.

Automatic object detection automatic detection of the objects in an image. A set of parameters
(positions, brightness, ellipticity etc) are computed for all the objects detected.

Surface photometry Surface photometry of galaxies, including determining radial profiles and
fitting elliptical isophotes.

Image patching interactive removal of image blemishes and contaminating objects from an
image. For example, foreground stars might be removed from a galaxy image.

Properties of image regions statistics, extraction and removal of shaped regions of an image.

http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_display
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_view
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_inspect
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_graphics
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_printing
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_astrometry
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_photom
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_extract
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_esp
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_patch
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_regions
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Image comparison two images can be compared by either plotting one as a set of contours su-
perimposed on the other or by blinking between the two images (cf the ‘blink comparator’
used to compare two photographic plates).

Object position and statistics two-dimensional Gaussian fits to single or multiple objects.

Polarisation plotting polarisation maps can be plotted, regions selected from them etc. These
facilities are intended to be used in conjunction with the POLPACK package for polarimetry
and spectropolarimetry (see SUN/223[1]).

Profiles of rectangular regions Interactive averaged profiles along the x and y axes of a rectan-
gle.

3.3 Catalogues and Online Resources

Catalogues and image stores Access to remote on-line catalogues, image stores and archives
via the Internet. Local catalogues can also be read and written.

4 Data Formats

GAIA can access images in various different data formats. The ones that you are mostly likely
to encounter are FITS images and NDF files, though there are numerous other possibilities,
including the IRAF format and old Figaro DST files.

In GAIA (and to anticipate the recipes of Part II) you can check which formats are currently
available by clicking on the File Type: button in the file-picker window (see the recipe in
Section 8). Be careful that you do not inadvertently set the button to specify just one of the
formats; it is usually best left set to ‘any’.

The basic GAIA image display facilities read FITS files. The more astronomical functions
usually require files in Starlink’s NDF format. However, any necessary format conversions are
performed automatically and invisibly ‘on-the-fly’ by applications in the CONVERT package
(see SUN/55[4]), and you will not normally be aware that they are happening. It is possible to
configure the range of formats currently available to CONVERT. You are unlikely to need to
make such a configuration, but if you choose to do so then SSN/20[22] gives the requisite details.
However, you should ensure that FITS continues to be one of the formats available (because the
basic image display functions read FITS files directly).

A full description of the NDF and FITS formats is beyond the scope of this cookbook. The NDF
(n-dimensional Data Format; see SUN/33[19]) is the native Starlink format. The FITS4 (Flexible
Image Transport System) format is in widespread use in astronomy. There is a brief introduction
to the FITS format in SC/5[7].

In both the NDF and FITS formats, and indeed other common astronomical formats, the infor-
mation stored in the file includes more than just the array of values for the two-dimensional

4The original FITS format was proposed by Wells et al.[23] in 1981. However, it has been developed and enhanced
over the years. The FITS standard is now maintained and documented by the FITS Support Office of the Astrophysics
Data Facility at the NASA Goddard Space Flight Center (see URL: http://fits.gsfc.nasa.gov/fits_home.html ).
Though FITS is basically an astronomical format it is sometimes mentioned in books about standard image formats.
See, for example, Graphics File Formats by Kay and Levine[12].

http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_compare
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_statistics
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_polarimetry
http://www.starlink.ac.uk/cgi-bin/htxserver/sun223.htx/sun223.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/gaia.htx/gaia.html?xref_xyprofile
http://www.roe.ac.uk/acdwww/gaia/catalogues.html
http://www.starlink.ac.uk/cgi-bin/htxserver/sun55.htx/sun55.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/ssn20.htx/ssn20.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun33.htx/sun33.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sc5.htx/sc5.html?xref_FITS
http://www.starlink.ac.uk/cgi-bin/htxserver/sc5.htx/sc5.html?xref_FITS
http://www.starlink.ac.uk/cgi-bin/htxserver/sc5.htx/sc5.html?xref_
http://fits.gsfc.nasa.gov/fits_home.html
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image. Various other header or auxiliary information describing and annotating the image is
also included. Typical auxiliary information might include: the instrument and telescope used,
the date and time of observation, details of the instrumental set up etc. In the jargon of computer
science such header information is often called ‘metadata’, though this term is rarely used in
astronomy. Sometimes you may wish to examine this auxiliary information.

In GAIA (and again anticipating Part II) you can display the headers of a FITS image by clicking
on the View menu (on the menu-bar along the top of the main window) and choosing the
Fits Header. . . item (see the recipe in Section 8). Some alternative ways of listing the header
information for the NDF, FITS and a couple of other formats are given in Appendix B.2 of
SC/6[16].

Data files usually contain just a single image. However, both the FITS and NDF formats
allow files to contain more than one image, and occasionally you might encounter such a file.
Section 5.2 includes some notes on how to access a given image inside a file in this case.

The format of a data file is often indicated by specifying a ‘file-type’ at the end of the file-
name. NDF files have file-type ‘.sdf’. When accessing NDF files with GAIA the file-type may
optionally be omitted. FITS files usually have a file-type of ‘.fit’ or ‘.fits’.

4.1 World coordinate systems

Astronomical images often contain a so-called World Coordinate System (WCS). The WCS is
a prescription for converting pixel position indices (that is, indices into the two-dimensional
array representing the image) into physical units. In practice for direct images of a region of sky
the WCS will usually transform pixel indices into some celestial coordinate system, such as the
Right Ascension and Declination for some equinox and epoch. However, the underlying concept
of a WCS is much more general. For example, it is possible to have a WCS which transforms
pixel indices into x, y positions in micron on the face of the CCD chip which detected the image.
Alternatively, for spectroscopic data one index might be transformed into a wavelength in
Ångström. The WCS is stored with the other auxiliary information for the image, such as the
instrument and telescope used, the date and time of observation, etc.

GAIA handles all the details of manipulating the WCS automatically (ultimately by using the
Starlink AST library). All that you really need to know is that an image might or might not
contain a WCS, and an image with a suitable WCS can be annotated and examined in terms of
celestial coordinates rather than pixel indices.

The actual way in which the WCS details are stored in the auxiliary information for an image is
rather arcane. There are several conventions in use for FITS files, none of which are standard.
There are proposals for FITS WCS standards, but these are still under discussion at the time of
writing. If you are interested to find out more, the AST library is documented in SUN/210[20]
and SUN/211[21] and there are three papers describing the FITS WCS proposals (papers I5, II6

and III7). You should be aware, however, that all of these documents contain far more detail
than you need to know in order to use GAIA, and, moreover, they are not for the faint-hearted.

5ftp://ftp.cv.nrao.edu/NRAO-staff/egreisen/wcs.ps.gz
6ftp://ftp.cv.nrao.edu/NRAO-staff/egreisen/ccs.ps.gz
7ftp://ftp.cv.nrao.edu/NRAO-staff/egreisen/scs.ps.gz

http://www.starlink.ac.uk/cgi-bin/htxserver/sc6.htx/sc6.html?xref_EXAMFILE
http://www.starlink.ac.uk/cgi-bin/htxserver/sc6.htx/sc6.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun210.htx/sun210.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun211.htx/sun211.html?xref_
ftp://ftp.cv.nrao.edu/NRAO-staff/egreisen/wcs.ps.gz
ftp://ftp.cv.nrao.edu/NRAO-staff/egreisen/ccs.ps.gz
ftp://ftp.cv.nrao.edu/NRAO-staff/egreisen/scs.ps.gz
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4.2 Catalogue formats

The native format in which GAIA reads and writes the catalogues and tables which it plots
as image overlays is the so-called Tab-Separated Table (TST) format, which is described in
SSN/75[6]. GAIA can also read and write catalogues in the FITS tables, STL and ASCII_HEAD
formats. GAIA differentiates between these different formats by using the file-type at the end of
the file-name. Brief notes on the individual formats and their required file-types follow.

FITS tables a variant of the FITS format for storing catalogues and tables. Accepted file types:
.FIT .fit .FITS .fits .GSC .gsc

STL the Small Text List format used by CURSA (see SUN/190[5]). Accepted file types: .TXT
.txt

ASCII_HEAD the ‘ASCII Header’ format used by the EXTRACTOR package (see SUN/226[3]).
Accepted file types: .asc .ASC .lis .LIS

Mixed capitalisations, such as ‘.Fits’ are also recognised. GAIA interprets all other file formats
as indicating TST format catalogues (but note that CURSA requires TST format catalogues to
have a file-type of .TAB or .tab).

5 Starting GAIA

If you are working at a Starlink site then GAIA should automatically be available to you,
provided that your account is set up to access Starlink software, which will usually be the
case. No special quotas or privileges are required to run GAIA. However, it must be run on a
workstation console or X-display capable of receiving X-output. In practice GAIA requires a
colour display (strictly speaking it will run on a black and white one, but any image displayed
is not visible).

GAIA is usually run from the Unix shell. Simply type:

% gaia &

(The ‘&’ merely makes gaia run as a detached process so that you can, if you wish, continue to
issue Unix commands from the command line.) After a few moments the main GAIA window
will appear.

Now click on the File menu, which is the leftmost item in the menu-bar along the top of the
window. Click on the Open. . . item. A file-picker window appears which allows you to choose
the image file to be displayed. The final appearance should be similar to Figure 1. See the recipe
in Section 8 for further details.

Alternatively, the required file can be specified on the command line when GAIA is started:

% gaia file-name &

http://www.starlink.ac.uk/cgi-bin/htxserver/ssn75.htx/ssn75.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun190.htx/sun190.html?xref_STLTUT
http://www.starlink.ac.uk/cgi-bin/htxserver/sun190.htx/sun190.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun226.htx/sun226.html?xref_
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for example:

% gaia ngc1275jkt.sdf &
% gaia ngc1275hri.fits &

The first example is a Starlink NDF file, the second a FITS file (see Section 4 for the data formats
accessible to GAIA).

If you have already started GAIA and want to display a different image from the Unix command
line then type:

% gaiadisp file-name

It is also possible to plot an image in a given window by specifying its ‘clone number’:

% gaiadisp file-name clone-number

for example:

% gaiadisp ngc1275.sdf 2

The plot will be displayed in a window titled ‘GAIA::Skycat:file-name(2)’. If this window does
not exist then it will be created.

5.1 Using GAIA from IRAF

GAIA can be run from the IRAF command language, cl (see SG/12[15] for an introduction to
IRAF on Starlink systems). However, before this option is available the GAIA package must
have been included in the version of IRAF that you are using. This customisation will usually
already have been performed if you are using IRAF at a Starlink site.

Assuming that the IRAF GAIA package is available, your first step must be to initialise it. From
the IRAF cl type:

cl> gaia

(Alternatively, if you think that you will often want to use GAIA from within IRAF, then you
could include this step in your IRAF login.cl file.)

To display an image type:

cl> gaiadisp image plane-number

image is the image to be displayed and plane-number is the number of the IRAF display plane in
which the image is to appear (which is identical to the GAIA clone number). For example:

cl> gaiadisp dev$pix.imh 1

will display the default IRAF image in display plane 1. The image will either be displayed into
an existing GAIA window, or a new window will be created, as required. Note that because
GAIA is not a native IRAF image display task it does not support any of the IRAF cursor
commands.

http://www.starlink.ac.uk/cgi-bin/htxserver/sg12.htx/sg12.html?xref_
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5.2 Multiple image files and image sections

Some data formats, notably FITS and NDF, can include more than one image in a single file. If
you encounter such a file then you need to specify which image is to be displayed. In a FITS file
each image occurs in a separate ‘extension’, which is identified by a sequential integer number.
To display a FITS extension image, either open the disk file and choose the extension from the
‘HDU’ selector window that appears (HDU or ‘Header and Data Unit’ is FITS jargon for an image
and its associated auxiliary information), or add the extension number to the disk-file name:

% gaia mef_file.fits’[2]’

(the quotation marks embedded in the file-name in this example are to prevent the square
brackets from being interpreted by the Unix shell). The first image in the FITS file is called the
‘primary array’ and is numbered 1.

A similar mechanism exists for NDFs stored in container files at other than the top-level (‘con-
tainer file’ is NDF jargon for a file which contains one or more NDFs):

% gaia hdscontainer.ndf_1

In this case any other NDFs stored at the same level in the container file will also be shown in a
selector window. It is also possible to access an ‘NDF slice’, that is, a portion of an image rather
than the whole thing (this facility can be useful for very large images). For example type:

% gaia hdscontainer.ndf_1’(200:500,100:700)’

See SUN/33[19] for further details of specifying NDF slices. This notation can also be applied to
FITS files and other ‘foreign’ formats:

% gaia file.fits’(300:700,300:700)’

Note, however, that here the FITS file will now be accessed as a foreign format; that is, it will
automatically be converted to an NDF prior to being read.

5.3 Demonstration mode

GAIA has an automatic ‘demonstration mode’ which shows many of its facilities. To run this
demonstration: move to an empty directory and start GAIA as described above. Then click on
the Image-Analysis menu in the menu-bar at the top of the window and choose the Demonstration
mode. . . item. A window will appear asking if you wish to copy the files for the demonstration
into your current directory. Click Yes. A further window with preliminary information about
the demonstration will appear. Click on the Start button. The demonstration will now run
completely automatically, without further intervention. Annotation describing the facilities
being demonstrated will appear in the information window as the demonstration proceeds.

Note that the demonstration contains flashing images: abort it if these might affect you.

http://www.starlink.ac.uk/cgi-bin/htxserver/sun33.htx/sun33.html?xref_
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6 Obtaining Assistance

If you encounter a problem with GAIA, and particularly if it does not appear to be available at
your site, then in the first instance you should contact your local site manager.

GAIA has a ‘home page’ at URL:

http://www.starlink.ac.uk/gaia/

which includes a current list of known bugs and work-arounds to circumvent them. If your
problem is not covered by this list then you can send a bug-report or query by electronic mail to:

gaia@star.rl.ac.uk

Suggestions for improvements and enhancements to GAIA are also welcome and should be
submitted by the same route.

http://www.starlink.ac.uk/gaia/
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Part II

The Recipes

7 Introduction

This part of the cookbook provides a set of detailed recipes for performing some simple tasks
with GAIA. The topics covered are:

• displaying an image (Section 8),

• retrieving remote images and catalogues via the Internet (Section 9),

• using World Coordinates (Section 10),

• superimposing and contouring images (Section 11),

• astrometric calibration of an image (Section 12),

• automatic object detection (Section 13),

• measuring instrumental magnitudes (Section 14).

Strictly speaking these recipes can be read in any order, and you can simply turn to the ones
that seem most relevant to your work. However, the first five form a natural sequence. Also, the
first is particularly simple and introductory. Example data are provided with the cookbook so
that you can work through the recipes yourself. On Starlink systems these example data are
kept in directory:

/star/examples/sc17

All the files in this directory should be copied into your current directory before attempting any
of the recipes. You might wish to create a new, empty directory for this purpose. You should
also ensure that your terminal or workstation is configured to receive X-output.

All the recipes in this part of the cookbook use observations of the type I Seyfert Galaxy NGC
1275 (also known as 3C 84). The J2000 coordinates of this galaxy are:

α = 3h 19m 48s.16, δ = +41◦ 30′ 42′′1

Its V magnitude is 12.5 and its morphological classification Ep (these details were obtained from
SIMBAD8).

8http://simbad.u-strasbg.fr/Simbad

http://simbad.u-strasbg.fr/Simbad
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8 Displaying an Image

This introductory recipe demonstrates displaying an image, which is the simplest use of GAIA.
The image used is file ngc1275jkt.sdf, a reduced V band CCD image of the galaxy NGC
1275 obtained with the Jacobus Kapteyn Telescope (JKT) on La Palma. It was derived from
observations included on the CD-ROM Astronomical Images by Jaffe[11]. However, the same
data are publicly available from the ING (Isaac Newton Group) data archive maintained at the
Institute of Astronomy, University of Cambridge. See URL:

http://archive.ast.cam.ac.uk/

For technical reasons there are some differences in the arrangement of the FITS headers in the
archive and CD-ROM versions of the files but both contain identical astronomical information.

ngc1275jkt.sdfwas created by reducing the raw observations using CCDPACK (see SUN/139[9])
following the recipe in SC/5[7]. The data reduction is not considered further here. The image is
in the NDF data format (see Section 4 for details of the data formats available to GAIA). If you
prefer you could use an image of your own rather than this one.

Assuming that you have copied all the example data files for the cookbook into your current
directory (as described in Section 7, above) and configured your terminal or workstation to
receive X-output, then proceed as follows.

(1) Start GAIA by typing:

% gaia &

The ampersand (‘&’) is, of course, simply to run GAIA as a detached process, so that you
can continue to issue Unix commands from the command line. A window displaying a
start-up message should be displayed, shortly followed by the main GAIA window. If
these windows do not appear then GAIA is not properly installed at your site; in the first
instance seek assistance from your site manager.

(2) Load file ngc1275jkt.sdf by clicking the File menu (leftmost of the options in the menu-
bar at the top of the window), selecting Open. . . and using the file-picker which appears
to choose the appropriate file.

(3) The file should open, but the main display window will probably be mostly dark, with
just a few white dots corresponding to the brightest parts of the image. Set some of the
display options as follows:

(a) select the range of intensities in the image to be displayed: click the Auto Cut: button
(in the middle right of the control panel in the centre top of the window) and set it to
98%,

(b) set the magnification: click the Scale: button (in the bottom left of the control panel in
the centre top of the window) and set it to 1/2x,

(c) set the colour table: click the Color Map: button (in the lower right of the control panel
in the centre top of the window) and set it to heat.

http://www.ast.cam.ac.uk/
http://www.cam.ac.uk/
http://archive.ast.cam.ac.uk/
http://www.starlink.ac.uk/cgi-bin/htxserver/sun139.htx/sun139.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sc5.htx/sc5.html?xref_
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Figure 1: A V band CCD image of the galaxy NGC 1275. The image was obtained
with the Jacobus Kapteyn Telescope (JKT) on La Palma
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The display should now look something like Figure 1.

(4) You can inspect the header information associated with the image (see Section 4) by
clicking on the View menu (second on the left on the menu-bar along the top of the main
window) and choosing the Fits Header. . . option.

Note that this option will work with images in the NDF format as well as those in the FITS
format (because the NDF format can contain FITS-like header information which GAIA
can access).

(5) GAIA has many other functions and options and you may want to spend a while exploring
some of them. Similarly, you might also like to examine the other images included in the
examples.

On-line help is available from the Help menu at the extreme right of the menu-bar at the top
of the window. If you click on this menu and choose the Help topics index. . . item then the
introductory page of the GAIA on-line help information will appear (see Figure 2). From
this page you can follow hyper-links to further pages giving notes on how to perform
numerous common tasks with GAIA. You are likely to find this help information very
useful.

Figure 2: The introductory GAIA help page

(6) When you have finished, close GAIA by clicking on the File menu and choosing the Exit
option.
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9 Retrieving Remote Images and Catalogues

When using remote facilities, such as those described in this recipe, you should ensure that
you are both familiar with and comply with any obligations which they impose on you, such
as correct acknowledgement of the use of data or services etc.

This recipe demonstrates how to retrieve an image of a specified region of sky from a remote
archive and to overlay it with objects extracted from a remote catalogue. In both cases the data
are retrieved via the Internet. As an example a region centered on the galaxy NGC 1275 will be
used. Recall that the J2000 coordinates of this galaxy are:

α = 3h 19m 48s.16, δ = +41◦ 30′ 42′′1

A region will be extracted from the on-line version of the DSS (Digitised Sky Survey)9 at ESO.
The DSS is a photographic survey which covers the entire sky. It was constructed by the Space
Telescope Science Institute (STScI) by digitising and combining surveys conducted with the
Palomar and UK Schmidt telescopes (a UK mirror10 is available as part of the LEDAS data
archive service at the Department of Physics and Astronomy, University of Leicester). The
DSS image will then be overlaid with objects extracted from the USNO11 PMM astrometric
catalogue[13].

The SuperCOSMOS image surveys12 also available from GAIA return images which have
catalogues of objects detected in the images already attached and so combine the two stages
into one operation. However, the SuperCOSMOS surveys currently only cover the sky south of
Declination +3◦.

If the coordinates of your target region or object are not for epoch and equinox J2000 then you
should convert them to this system. COCO (see SUN/56[18]) is available for this purpose.
Though the target coordinates can be converted within GAIA it is probably better to convert
them prior to starting it.

(1) Start GAIA. Type:

% gaia &

The ampersand (‘&’) is simply to run GAIA as a detached process, so that you can continue
to issue Unix commands from the command line. After a few moments the main GAIA
window should appear.

(2) The first step is to retrieve a two-dimensional image of the region of sky containing your
target region or object. Click on the Data-Servers menu, located towards the right of the
menu-bar at the top of the main window. Choose the Image Servers option and then
Digitized Sky at ESO from amongst the list of servers (it will probably be the only choice).
If the Digitized Sky at ESO is not amongst the choices offered then see Section 9.1, below.

9http://stdatu.stsci.edu/dss/
10http://ledas-www.star.le.ac.uk/DSSimage/
11http://www.nofs.navy.mil/
12http://www-wfau.roe.ac.uk/sss/

http://stdatu.stsci.edu/dss/
http://ledas-www.star.le.ac.uk/DSSimage/
http://ledas-www.star.le.ac.uk/
http://www.star.le.ac.uk/
http://www.nofs.navy.mil/
http://www-wfau.roe.ac.uk/sss/
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Figure 3: Window to retrieve a remote image of a region or object from the DSS

A window similar to Figure 3 and titled Digitized Sky at ESO (1) should appear; it allows
you to specify the region of sky to be retrieved.

• You can simply enter the name of your target object in the Object Name: box, if
you know it. GAIA will attempt to resolve the name of the object and look up its
coordinates. Here simply enter ‘ngc 1275’ (any embedded spaces are ignored).
• However, often you will need to enter the coordinates directly. The units and formats

required are:

α (Right Ascension): sexagesimal hours with a colon (‘:’) as a separator,
δ (Declination): sexagesimal degrees with a colon (‘:’) as a separator.

In the present example the values required are:

α: 3:19:48
δ: 41:30:42

• You also need to specify the height and width of the region to be retrieved. These
values are specified in minutes of arc. In the present example values of 7′ should be
specified, which is slightly larger than the field of view of the V band CCD image of
NGC 1275 used in the previous recipe (Section 8).

When the values are set, click on the Get Image button. After a few moments the retrieved
image should be displayed in the main GAIA window. A small window entitled ‘FITS
HDUs (1)’ may also appear. Click on Close to close this window. Then click on Close to
close the Digitized Sky at ESO (1) window.

(3) You may wish to save the retrieved image as a file for future use. Click on the File menu
(the leftmost item in the menu-bar along the top of the main window) and choose the Save
as. . . item. A window allowing you to save the image as a file will appear. The file will be
written in FITS format. It is usual to end the file-name with a file-type of ‘.fits’ or ‘.fit’.
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(4) You may wish to adjust the appearance of the displayed image. The most likely items
to change are Colors. . . and Magnification in the View menu (second from the left in the
menu-bar along the top of the window).

For example, click on the View menu and select the Colors. . . option. A panel will appear.
Set:

• the colour scale algorithm to Linear,

• the colormap to ramp,

• the intensity to neg.

Then click on the Close button. Set the magnification by clicking on the Scale: button (in
the bottom left of the control panel in the centre top of the window) and setting it to 2x.

The display should now look something like Figure 4, which is a a reasonable approxima-
tion to the appearance of the original photographic plate.

Figure 4: Retrieved Digitised Sky Survey (DSS) image centred on NGC 1275
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(5) Various remote catalogues are accessible from GAIA. The present recipe extracts objects
from the USNO13 PMM astrometric catalogue[13] and overlays them on the image.

First click on the Data-Servers menu, towards the right of the menu-bar at the top of the
main window. Choose the Catalogs option and then USNO at ESO from amongst the list
of catalogues (it will probably be towards the bottom of the list). If USNO at ESO is not
amongst the choices offered then see Section 9.1, below.

A window similar to Figure 5 and titled USNO at ESO (1) should appear; it allows you
to retrieve objects from the catalogue. The central position and minimum and maximum
radius should be already filled in (the values have been obtained from the two-dimensional
image). The ‘Brightest (min):’ and ‘Faintest (max):’ boxes allow these quantities to be set, if
desired. However, in the present example they can be left blank, and all the objects in the
PMM which overlay the image will be selected.

Figure 5: Window to retrieve objects from a remote version of the USNO PMM catalogue

Simply click on the Search button (in the bottom left of the window). After a couple of
moments the selected objects are listed in the Search Results box and overlaid on the image
in the main window.

A useful feature for identifying objects in the list with the corresponding plotted symbol
is that if you position the cursor over either a plot symbol or a row in the table and click
with the left mouse button the corresponding row and plot symbol are highlighted.

To save the selected objects as a text file click on the File menu in the USNO at ESO (1)

13http://www.nofs.navy.mil/

http://www.nofs.navy.mil/
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window (the leftmost item in its menu-bar) and choose either Save as. . . or Print. . . . In
both cases a window will appear which allows you to save the list. Note that though both
options produce text files they are in different formats.

If you choose the Save as. . . option the catalogue of objects will be saved as a file. The
format in which this catalogue is saved depends on the file-type specified at the end of
the file-name (see Section 4.2). Catalogues saved in the FITS tables, TST or STL formats
can subsequently be imported into CURSA (see SUN/190[5]) which provides additional
catalogue manipulation facilities.

When you have finished click the Close button to close the USNO at ESO (1) window.

(6) To close GAIA click on the File menu (the leftmost item in the menu-bar along the top of
the main window) and choose the Exit option.

9.1 Restoring catalogue access

It is possible to configure the set of catalogues and sky surveys which GAIA can access, though
the details are not germane here. However, if the Digitized Sky at ESO survey or USNO at ESO
catalogue do not appear in the lists of Image Servers and Catalogs respectively then the most
likely reason is that the default list of catalogues and surveys has been substituted with one
which does not include them. The simplest way to restore access is to revert to using the default
list. GAIA configuration files are kept in subdirectory .skycat of your top level directory. To
restore the default catalogues and surveys you should delete (or rename) file:

~/.skycat/skycat.cfg

and then restart GAIA.

9.2 Using a proxy server

Access to the World Wide Web at your site may be restricted (by a firewall or maybe just by
policy), so that it is only available through a ‘web cache’ or proxy server. If you are in this
situation you will need to configure GAIA so that its remote catalogue access will work. Proceed
as follows.

(1) Start GAIA, select the Data-Servers menu (in the menu-bar along the top of the main
window) and choose any remote catalogue.

(2) The catalogue window will appear (similar to Figure 5). Click on the Options menu in its
menu-bar and choose the Proxies. . . item.

(3) a Proxies window will appear. You should fill in the various fields (consult your system
manager if you are unsure what to enter). Then click on OK.

http://www.starlink.ac.uk/cgi-bin/htxserver/sun190.htx/sun190.html?xref_
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10 Using World Coordinates

This recipe demonstrates the simple use of World Coordinates in GAIA. Recall that a World
Coordinate System (WCS; see Section 4.1) relates the positions of pixels in an image to celestial
coordinate systems on the sky. In practice it allows you to display and annotate images in terms
of celestial coordinates.

Some images include a WCS as part of the auxiliary information that they contain; others do not.
For example, ngc1275jkt.sdf, the JKT image used in the recipe in Section 8 does not possess
a WCS, but images retrieved from the DSS (as in the recipe in Section 9) do. It is possible to
use GAIA to add a WCS to an image, and the recipe in Section 12 is an example doing so. The
present recipe merely gives some examples of using a WCS.

The recipe uses file ngc1275dss.sdf which is an image centred on the galaxy NGC 1275 extracted
from the DSS. It will be very similar to the image that you created in the recipe in Section 9, and
you could substitute your own image if you prefer.

Load file ngc1275dss.sdf into GAIA and adjust the colour table so that you can see the stars
and galaxies. The display should look something like Figure 4.

10.1 Reading off the Right Ascension and Declination

It is straightforward to read off the approximate Right Ascension and Declination of any object
in the image.

(1) The x, y pixel positions and the Right Ascension and Declination of the current cursor
position are shown in the boxes labelled: X:, Y:, α: and δ: in the control panel in the middle
of the upper portion of the main window. To find the approximate coordinates of a star
simply position the cursor over it and read them off.

(2) In a DSS image J2000 equatorial coordinates are shown by default. It is possible to
configure GAIA to display other celestial coordinates. Click on the Image-Analysis button
in the menu-bar along the top of the main window and choose Change coordinates and
then Celestial coordinates. . . .

A window appears which allows you to specify the coordinate system. Choose the one
required (perhaps ecliptic coordinates) and then click the Accept button.

Henceforth coordinates are displayed in the chosen system (but note that the coordinate
boxes are still labelled ‘α:’ and ‘δ:’, even if ecliptic or Galactic coordinates have been
selected).

Also, the coordinates are only updated when the cursor moves. Thus, if it is already
positioned over the star that you are interested in, then you need to nudge it off the object
and return it to the required position.

(3) Depressing the Caps Lock key will prevent the x, y and α,δ values being updated as the
cursor moves. This facility is useful, for example, if you wish to preserve the coordinates
whilst moving the cursor to another window.

(4) A list of positions in an image can be selected and saved as a text file by selecting the
Positions. . . item from the Image-Analysis menu (in the menu-bar along the top of the main
window).
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10.2 Showing celestial coordinate grids

GAIA can superimpose a celestial coordinate grid over the image.

(1) Click on the Image-Analysis button in the menu-bar along the top of the main window
and choose Overlay axes grid. . . . A window will appear with numerous options. You can
change some of these if you wish, but there is no need to do so. Simply click on the Draw
button and an axis grid is drawn in the current celestial coordinate system.

The grid is removed when you click Close to close the window.

(2) To show a grid in a different celestial coordinate system click on the Image-Analysis button
in the menu-bar along the top of the main window and choose Change coordinates and then
Celestial coordinates. . . . A window appears which allows you to specify the coordinate
system. Choose the one required and then click the Accept button.

Then repeat step 1, above, and a grid will be drawn in the new system.

10.3 Measuring angular separation

To measure the approximate angular separation between two objects simply position the cursor
over the first of them, and then click and hold down mouse button three. Continuing to hold
down this mouse button, move the cursor until it is positioned over the second object.

A ‘rubber band’ cursor is drawn as the mouse moves. It shows the vector between the original
and current positions and also the offsets in two orthogonal coordinates. The separation and
offsets are all labelled with their size in minutes of arc, with a sexagesimal subdivision into
seconds.

The cursor disappears when the mouse button is released.
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11 Superimposing and Contouring Images

This recipe is an example of superimposing two images in order to compare them. GAIA has two
mechanisms for superimposing images: displaying two or more images and rapidly blinking
between them (in a manner analogous to the ‘blink comparator’ used to compare photographic
plates), and displaying one image as a set of contours superimposed on a display of the other.
This recipe demonstrates the latter technique.

GAIA aligns images by using their World Coordinate Systems (WCS; see Section 4.1). Images
that do not have a WCS are aligned by assuming that their pixel coordinates are coincident,
which can be useful in some circumstances. Images extracted from the Digitised Sky Survey
(DSS) have a WCS, and this recipe will use the DSS image of NGC 1275 retrieved in Section 9.
Contours constructed from an X-ray image of the same region of sky will be drawn on top of
it. The X-ray image is contained in file ngc1275hri.fits. It was obtained with the HRI (High
Resolution Imager) on-board the ROSAT X-ray astronomy satellite (Röntgensatellit). The copy
used here was retrieved from the LEDAS14 data archive service at the Department of Physics
and Astronomy, University of Leicester. The image is in FITS format (see Section 4 for details of
the data formats available to GAIA) and it too contains a WCS.

Proceed as follows.

(1) It is useful to examine the X-ray image of the NGC 1275 region before trying to contour it.
(You could skip these steps if you were already familiar with the properties of the image
to be contoured). Start GAIA and load file ngc1275hri.fits.

(2) Adjust the colour so that the very nucleus of the X-ray emission is clearly visible. For
example, set the Auto Cut: to 100%. Then click on the View menu and select the Colors. . .
option. A panel will appear. Set the colour scale algorithm to Logarithmic, the colormap to
heat and the intensity to ramp. The display should now appear similar to Figure 6.

It is immediately obvious that the sky appears very different at X-ray and optical wave-
lengths. Also, by moving the cursor from one edge of the image to the other and noting
the change in Right Ascension or Declination it is apparent that the image is rather larger
than the 7′ field extracted from the DSS.

(3) Aside: you might be interested to check that the X-ray image really is centred on NGC
1275.

(a) Click on the Data-Servers menu, towards the right of the menu-bar at the top of the
main window and choose the Catalogs option. Select the RC3 at CADC catalogue,
which is a version of the Third Reference Catalogue of Bright Galaxies[17] provided by
the CADC (Canadian Astronomy Data Center)15.
A window similar to Figure 5 should appear. Click on the Search button (in the
bottom left of the window) and after a couple of moments the galaxies in the RC3
which overlay the X-ray image will be listed in the Search Results box and plotted in
the main window.

14http://ledas-www.star.le.ac.uk/
15http://cadcwww.dao.nrc.ca/

http://ledas-www.star.le.ac.uk/
http://www.star.le.ac.uk/
http://www.star.le.ac.uk/
http://cadcwww.dao.nrc.ca/
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Figure 6: An X-ray image centred on the galaxy NGC 1275. The image was obtained
with the HRI instrument on the ROSAT satellite
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(b) One of the plotted objects is almost exactly coincident with the centre of the X-ray
emission. If you click on this symbol the line for NGC 1275 is highlighted in the
Search Results box.

(c) If you double-click on the line for NGC 1275 in the Search Results box the correspond-
ing symbol in the image is labelled as NGC 1275.

(4) Before contouring an image it is useful to have some idea of the range of numbers that it
contains. One possibility is to draw a slice through the image. Click on the View button
on the menu-bar along the top of the main window and choose the Slice. . . item. You
can interactively define a slice through the image which is then plotted as a graph (see
Figure 17 in Section 14, below, for an example).

Alternatively, click on the View button on the menu-bar along the top of the main window
and choose the Pixel Table. . . item. A table showing the values of a small grid of pixels
centred on the current cursor position is displayed. You can move the cursor over the
image examining the values. For the present purposes the largest grid permitted, 9x9, is
the most appropriate.

You will probably want to experiment with these options for a while.

(5) You are now ready to proceed with contouring the X-ray image on top of the DSS one.
Load the DSS image ngc1275dss.sdf into GAIA. If you prefer you can substitute the DSS
image that you retrieved whilst working through the recipe in Section 9; they should be
very similar.

(6) Set the colour table and magnification as in Section 9: click on the View menu and select
the Colors. . . option. Set the colour scale algorithm to Linear, the colormap to ramp and the
intensity to neg. Then click on the Close button.

Set the magnification by clicking on the Scale: button (in the bottom left of the control
panel in the centre top of the window) and setting it to 2x.

The appearance of the display should now be similar to Figure 4.

(7) Click on the Image-Analysis button on the menu-bar along the top of the main window and
choose the Contouring. . . item. A window similar to Figure 7 should appear.

(8) Click on the Choose file. . . button and load file ngc1275hri.fits.

(9) Click on the Generate button (on the left hand side of the window, immediately below
Levels). A window similar to Figure 8 should appear. Set the following values:

Number: 5

Algorithm: linear

Start: 100

Increment: 75

The window should now appear exactly like Figure 8. (In this recipe the required contour
levels are already prescribed, however, the first time you contour an image you will
probably need to experiment to find suitable levels. One way to do so is to set the
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Figure 7: Window for defining contour details

Figure 8: Window for defining contour levels
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Algorithm: to automatic and allow GAIA to generate the levels itself. If these levels are not
satisfactory you can adjust them manually.)

Click on the Generate button and the appearance of the window should revert to that in
Figure 7.

(10) For all five of the specified contours click on the colour boxes and set them to red (which
makes the contours easier to see if you are using the colour table set up above).

(11) Click on the Draw Contours button. Contours of the X-ray image will now be drawn
superimposed on the X-ray image. The appearance of the plot should be similar to
Figure 9.

Figure 9: Contours derived from the ROSAT HRI X-ray image of NGC 1275 superim-
posed on a DSS image of the same region
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It is immediately obvious that the X-ray emission is centred on NGC 1275 and also that
it extends beyond the optical limits of the galaxy (recall that the faintest contour drawn
corresponds to quite a bright level in the X-ray image).

(12) When you have finished inspecting the image click on the Close button and the contours
will disappear.

11.1 Contouring the displayed image

Sometimes you might wish to plot contours generated from the displayed image, rather than
superimposing those from another image. The procedure is very similar.

(1) Display the required image.

(2) Click on the Image-Analysis button on the menu-bar along the top of the main window and
choose the Contouring. . . item, as before. A window similar to Figure 7 should appear.

(3) Do not click on the Choose file. . . button to specify the image to be contoured. Rather,
proceed immediately to specifying and generating the contour levels by clicking on the
Generate button and then proceed as before.



SC/17.1 —Astrometric Calibration 28

12 Astrometric Calibration

This recipe describes how to apply an astrometric calibration to an image. In this context an
‘astrometric calibration’ is a mathematical transformation relating the x, y positions of pixels in
the image array to celestial coordinates on the sky. Applying an astrometric calibration is just
another term for creating a World Coordinate System (WCS; see Section 4.1) for the image, with
the World Coordinates being celestial coordinates.

GAIA provides numerous options for astrometric calibration, only one of which will be used
here (though Section 12.4, below, gives a few hints about what else is available). In most of
the techniques stars occurring in the image are used as fiducial marks and a transformation is
defined between their x, y pixel positions measured in the image and their celestial coordinates
obtained from an astrometric reference catalogue. The most interactive (and problematic) part
of the procedure is identifying a given object in the image with the corresponding entry in an
astrometric reference catalogue.

The principal information which you need to know about an image before attempting astrometric
calibration is the approximate position on the sky corresponding to the centre of the image and
the size of the field of view. The former can usually be obtained from examining the auxiliary
information included with the image (see Section 4). The latter may also be found in the auxiliary
information or from the documentation for the instrument or telescope. If you have no prior
information whatsoever about the region of sky observed then astrometric calibration will
usually be impossible.

In this recipe an astrometric calibration will be created for the V band CCD image of NGC 1275
obtained with the JKT which was used in the recipe in Section 8. The field of view of this image
is about six minutes of arc in each axis.

The process of creating the astrometric calibration divides naturally into three stages:

(1) finding suitable astrometric reference stars,

(2) creating a preliminary astrometric calibration,

(3) creating a final accurate astrometric calibration.

Each stage is described separately in individual sub-recipes below.

12.1 Finding astrometric reference stars

The purpose of this stage is to find a small number of astrometric reference stars, imaged on the
CCD frame, which can be used to define the preliminary astrometric calibration. Traditionally
finding reference stars is a long-winded task involving consulting printed atlases and catalogues.
However, the on-line resources available to GAIA allow the process to be automated and
simplified. Proceed as follows.

(1) You need to extract a region of the Digitised Sky Survey (DSS) roughly corresponding to
the region imaged in the CCD frame. The first part of the recipe in Section 9 gives exactly
the procedure required. Either: repeat this procedure, load the image that you created
when previously working through Section 9 into GAIA, or load file ngc1275dss.sdf into
GAIA (the last is the required region, already extracted from the DSS).
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(2) Adjust the colour table until the image appears as in Figure 4. Click on the View menu and
select the Colors. . . option. A panel will appear. Set the colour scale algorithm to Linear,
the colormap to ramp and the intensity to neg. Then click on the Close button.

Set the magnification by clicking on the Scale: button (in the bottom left of the control
panel in the centre top of the window) and setting it to 2x.

(3) Overlay the DSS image with objects selected from the USNO at ESO catalogue, following
the second part of the recipe in Section 9.

(4) The next step is to choose five stars in the image to act as reference stars. These stars
should be:

• easily identified,

• reasonably bright,

• stars rather than galaxies (because star images have more precisely defined centres),

• isolated from other stars and galaxies (to avoid images which blend together),

• spread reasonably uniformly over the image,

• not very close to the edge of the image (later you will need to to identify the cor-
responding stars in the JKT image, and the two areas of sky are not exactly the
same).

Figure 10 shows five suitable stars in the DSS example image. To select the stars: hold
down the shift key and click on each star in turn (without releasing the shift key). As
you do so the selected star is highlighted in both the image and the catalogue windows.
You can add as many stars as you like, but five is adequate.

(5) Copy the selected stars to a new table dialogue box by clicking on the Options menu
in the catalogue dialogue box and choosing the Extract selected item. A new catalogue
dialogue box listing just the selected objects will appear. Henceforth you will work with
this catalogue dialogue box.

(6) To double-check which objects you have selected: click on the Graphics menu in the main
window and choose Clear. All the catalogue object markers will disappear.

Re-plot the selected objects by clicking on the Plot button towards the bottom of the new
catalogue dialogue box. Label the chosen objects by clicking on the Options menu in the
catalogue dialogue box menu-bar and choosing Label all objects.

(7) It is useful to print out a copy of the image with the reference stars marked, for use in the
next stage of the calibration. If you are using the colour table described above you will
need to adjust it so that the star identifications are legible, typically by inverting the image
to make the stars white against a dark background (as in Figure 10), rather than vice versa.

(8) Print out a paper copy of the image by clicking on the File option (the rightmost option in
the menu-bar along the top of the main window) and choose the Print... option, followed
by Image.... Use the ensuing dialogue box to save the image as a postscript file, which you
can then print.
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U1275_02196456

U1275_02197824

U1275_02200734

U1275_02201993

U1275_02198070

GAIA::Skycat

dss27172

ngc1275dss.sdf

3:19:48.17 41:30:41.2 J2000

acd Jan 03, 2002 at 14:12:29

Figure 10: DSS image with reference stars marked
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(9) Save the catalogue of selected objects. Click on the File menu in the USNO at ESO (1)
dialogue box (the leftmost item in its menu-bar) and choose the Save as. . . option. You
should specify a file-type of .lis so that the catalogue is saved in the ‘ASCII Header’
format (see Section 4.2).

You now have a list of suitable reference stars. You can quit GAIA at this point, but it is better to
proceed directly to the next stage of the recipe.

12.2 Creating a preliminary transformation

This stage of the recipe uses the five reference stars identified in the previous stage as ‘fiducial
marks’ to define a preliminary astrometric calibration. However, before starting, a superficial
glance at the DSS image (for example in Figure 4) and the JKT image (Figure 1) reveals that
they are rotated with respect to each other by 180◦. Sometimes uncalibrated images show such
gross rotations with respect to the standard orientation, sometimes they do not (the ‘standard
orientation’ has north at the top, east to the left and Right Ascension increasing from right to
left, that is ‘the wrong way round’). If they do then it is best to rotate them before attempting
the astrometric calibration.

This recipe assumes that GAIA is still running and that the catalogue of reference stars created
in the previous stage is still available. If not, then start GAIA and load either the local catalogue
of reference stars that you created in the previous stage, or file ngc1275usno.tab, which is the
equivalent example file.

(1) Load image ngc1275jkt.sdf into GAIA.

(2) Adjust the colour table and magnification:

(a) click the Auto Cut: button for 98% (in the bottom right of the control panel in the
centre top of the window),

(b) set the magnification: click the Scale: button (in the bottom left of the control panel in
the centre top of the window) and set it to 1/2x,

(c) set the colour table: click the Color Map: button (in the lower right of the control panel
in the centre top of the window) and set it to heat. Also set the Intensity Map: button
(directly below the Color Map: button) to default.

(3) Rotate the image to the standard orientation. Click on the button marked with two
horizontal arrows and then the one marked with two vertical arrows (these buttons are
located on the bottom row of the control panel towards the top of the main window).

It should now be straightforward to identify objects in the JKT image with the corre-
sponding objects in your print-out of the DSS image (created in the previous stage) or in
Figure 10.

(4) Click on the Image-Analysis button on the menu-bar along the top of the main window.
Choose the Astrometry calibration item and then Fit to star positions from the next menu.
The Fit astrometry reference positions dialogue box shown in Figure 11 should appear.



SC/17.1 —Astrometric Calibration 32

Figure 11: The main GAIA dialogue box used to create an astrometric calibration
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(5) Indicate the celestial coordinate system in which your star coordinates are expressed.
You do so by specifying suitable values using the coordinate system:, Equinox: and Epoch:
buttons. The coordinates will usually be FK5, equinox J2000 or for older catalogues
FK4, equinox B1950. The epoch defaults to J2000 for FK5 coordinates and B1950 for FK4
coordinates. For the present recipe the defaults of FK5, equinox J2000 are correct.

(6) To import the catalogue of selected reference stars click on the Grab button.

A selection box allowing you to specify the catalogue required will appear. The selected
reference stars will usually be the first catalogue in the list.

Once the catalogue has been imported the reference stars should be listed under ‘Reference
positions’ in the Fit astrometry reference positions dialogue box (Figure 11).

(7) You now need to measure the positions (in pixels) of these stars in the JKT image. Click on
the first reference star in the list, make a mental note of its star name and click on the Edit
button. The dialogue box shown in Figure 12 should appear.

Figure 12: The GAIA dialogue box holding details for a reference star

(8) Now click the Pick object... button. The dialogue box shown in Figure 13 should appear.
The black box in the upper portion of the window displays a section of the main image
centred on the position of the cursor. Referring back to your paper copy of the DSS image
or Figure 10, position the cursor over the corresponding first reference star (the star names
should match).

If there are any other significant features visible in the box, you should reduce the size of
the box using the ‘zoom buttons’ (‘Z’ and ‘z’) immediately below the image box.

Once you are happy with the sample size, re-position the cursor over the star and press
the left mouse button. The pixel coordinates at the centre of the feature are displayed in
the Image X: and Image Y: fields within the object picker dialogue box (Figure 12).

(9) Raise the object picker dialogue box (Figure 12). You should find that the pixel positions
of the star have been copied into the X and Y fields.

The star is now fully specified, so press the Enter button. After confirmation, this will
amend the details of the star in the list of reference stars in the Fit astrometry reference
positions dialogue box (Figure 11).

(10) Repeat the procedure for the remaining reference stars. All the dialogue boxes remain
open, so it is relatively simple to cycle through, measuring the positions of the remaining
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Figure 13: The GAIA object picker dialogue box
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stars. Hint: double-clicking on a star in the reference star list is equivalent to clicking on it
and then clicking the Edit button.

(11) Once you have entered all your reference positions, close the dialogue boxes shown in
Figures 12 and 13 by pressing the Close button in each one.

(12) Click on the Marker menu on the menu-bar along the top of the Fit astrometry reference
positions dialogue box (Figure 11), choose the Size option and set it to 21. This option makes
the markers a convenient size when plotted on the JKT image. You may also need to set
the Outline colour option to white (depending on which colour table you have set).

Now click the Fit/Test button in the same dialogue box. GAIA uses the known celestial co-
ordinates and measured positions of the reference stars to define an astrometric calibration.
It then uses this calibration to work out the pixel positions corresponding to each of your
reference coordinates, and displays markers in the main image at these pixel positions.
You should find that a marker is drawn more-or-less on top of each of your reference stars.

If the markers are not properly aligned then you have probably measured the wrong
star or entered an incorrect Right Ascension or Declination value. You should correct
the reference positions, and then press the Fit/Test button again. To correct the reference
positions: Edit the details of the offending star, as above, then press Fit/Test again to
re-calculate the astrometric calibration.

Cheat: you can load a file containing the celestial coordinates and measured positions for
the five stars marked in Figure 10. Click on the File menu in the menu-bar along the top of
the Fit astrometry reference positions dialogue box (Figure 11) and choose the Read positions
from a file. . . option. A file-picker appears. Use it to load file refstars.prelim. Then click
the Fit/Test button as before.

(13) Once you are happy with the calibration, press the Accept button.

(14) Finally, save the astrometric calibration by clicking the File menu button in the main
window, and then the Save as. . . menu item. Use the resulting dialogue box to save the
image (with the astrometric calibration) in a new file, perhaps called ngc1275jktpre.sdf.
This is most simply done by entering the new file name in the Selection box, and pressing
OK. Do not worry if a message is displayed saying that the WCS could only be saved as an
AST native representation.

12.3 Creating an accurate astrometric calibration

In some cases the approximate astrometric calibration derived in the previous stage will be
adequate. However, it is possible to use additional astrometric reference stars to refine it.
Assuming that you already have an approximate astrometric calibration proceed as follows.

(1) Query the USNO at ESO catalogue to find the objects that overlay the JKT image, following
the second part of the recipe in Section 9. Alternatively, you can load the example local
catalogue ngc1275usno.tab.

(2) Click on the Image-Analysis button on the menu-bar along the top of the main window.
Choose the Astrometry calibration item and then Fit to star positions from the next menu.
The Fit astrometry reference positions dialogue box (Figure 11) should appear.
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(3) Import the catalogue of reference stars by clicking on the Grab button and choosing the
appropriate catalogue.

(4) Click on the Clip button to remove reference stars which fall outside the image.

(5) Delete all the catalogue objects which correspond to galaxies, nebulae, blended double-star
images etc, none of which make good astrometric reference objects. The procedure to
delete an object is:

• click on the symbol for the object in the main window, so that the object is highlighted
in the catalogue window,

• click on the Delete button and then confirm that the object is to be deleted.

(6) When you are happy that you have removed all unsuitable objects, clear the catalogue
markers: click on the Graphics menu in the main window’s menu-bar and choose Clear.

(7) Click on the Centroid button in the Fit astrometry reference positions dialogue box to refine
the pixel positions for all the reference stars. New markers should be drawn over the JKT
image showing the revised positions of the reference stars.

(8) Click on the Fit/Test button and the revised calibration using all the reference stars will be
created.

If any unsuitable objects remain amongst the reference stars, or the fit is in some other way
unsatisfactory, then repeat the steps above to remove the offending objects and repeat the
fit.

When the fit is acceptable click the Accept button.

(9) Finally, save a version of the image with the revised calibration. Click on the File menu
button in the main window, choose the Save as item and use the resulting dialogue box to
save the image as a new file, perhaps called ngc1275jktast.sdf.

12.4 Variations

The preceding recipe has described just one of the numerous different ways to apply an as-
trometric calibration to an image using GAIA. Many images already contain an approximate
astrometric calibration and in such cases you can skip the first two stages of the recipe and
proceed directly to the third to create an accurate astrometric calibration.

Comparison images retrieved from the SuperCOSMOS surveys rather than the DSS already have
an object catalogue attached, making it un-necessary to retrieve a separate catalogue from the
USNO PMM (but remember that the SuperCOSMOS surveys are currently only available south
of Declination +3◦). Alternatively, you may not need to retrieve an object catalogue because
you already know accurate celestial coordinates for a set of reference stars in your image; they
might, for example, be listed in a scientific paper associated with the image. If you know an
approximate astrometric calibration (typically, the orientation, plate scale and approximate
central coordinates) for an image then you can simply type in the values (use the Astrometry
calibration item from the Image-Analysis menu and choose the Type in known calibration. . . option).

If you have a series of similar images all overlapping the same area of sky, you could determine
an astrometric calibration for the first using the method described. For the remaining images

http://www-wfau.roe.ac.uk/sss/
http://stdatu.stsci.edu/dss/
http://www.nofs.navy.mil/
http://www.starlink.ac.uk/cgi-bin/htxserver/sc5.htx/sc5.html?xref_PLATESCALE
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you can copy the WCS for the first image and then tweak it to fit the host image (use the Transfer
button in the Fit astrometry reference positions dialogue box).

You can transfer a set of reference stars, with measured positions, from a DSS or SuperCOSMOS
calibration image to the target image, then move the markers for the stars onto the corresponding
objects in the target image (move the cursor to the appropriate reference star marker, hold down
the left mouse button, move the cursor to the required position and then release the mouse
button) and measure the positions in the target image (click on the Centroid button). A reference
star can be deleted by positioning the cursor over the appropriate marker, holding down the
Control key and clicking on the left mouse button. After confirmation the corresponding
reference star is deleted.
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13 Automatic Object Detection

This recipe shows how to use GAIA to automatically detect objects in an image. A catalogue of
the objects detected is assembled, tabulating various properties for each object: position, flux,
ellipticity etc. The catalogue can both be examined within GAIA and saved as a file for further
analysis.

The object detection facilities of GAIA are provided by invoking the EXTRACTOR package (see
SUN/226[3]) ‘behind the scenes’, though you will just see seamless interaction via the GAIA
windows. EXTRACTOR is a version of the source-extraction program by Bertin and Arnouts[2].
It is particularly well-suited to the analysis of large extragalactic survey data, but also performs
well on other sorts of astronomical images.

The image used in this recipe is ngc1275jkt.sdf, a reduced V band CCD image of NGC 1275
obtained with the JKT (see the recipe in Section 8 for its provenance). The image contains a
mixture of stars and galaxies. Proceed as follows.

(1) Start GAIA and load image ngc1275jkt.sdf.

(2) You may wish to adjust the appearance of the displayed image. The most likely items to
change are the colour table (click on the Color Map: button in the lower right of the control
panel in the centre top of the window) and the magnification (click on the Scale: button in
the bottom left of the control panel).

(3) Click on the Image-Analysis button on the menu-bar along the top of the main dialogue
box and choose the Object detection. . . option. A dialogue box similar to Figure 14 should
appear.

(4) To generate a catalogue of the objects in the image simply click on the Detect objects button.

The object detection dialogue box (Figure 14) has numerous options, but you do not need
to adjust any of them; the default settings will generate a reasonable catalogue.

After a few moments, ellipses corresponding to the objects found will be drawn over
the image in the main window and a dialogue box similar to Figure 15 will be created,
showing the catalogue of objects detected.

(5) The catalogue dialogue box (Figure 15) has various options for manipulating the catalogue,
such as sorting and selecting objects; the on-line help gives the details.

The catalogue created is automatically written as a file in the EXTRACTOR ‘ASCII Header’
format. It is also possible to save a copy in one of the other catalogue formats described in
Section 4.2. Click on the File button on the left of the the menu-bar along the top of the
catalogue window and choose the Save as. . . option. A window allowing you to specify
the file-name required will appear. The format in which the catalogue is saved depends
on the file-type specified at the end of the file-name (again see Section 4.2). Catalogues
saved in the FITS tables, TST or STL formats can subsequently be imported into CURSA
(see SUN/190[5]) which provides additional catalogue manipulation facilities.

http://www.starlink.ac.uk/cgi-bin/htxserver/sun226.htx/sun226.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun190.htx/sun190.html?xref_
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Figure 14: The object detection dialogue box

Figure 15: Window showing a catalogue of automatically detected objects
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14 Measuring Instrumental Magnitudes

This recipe shows how to use GAIA to measure instrumental magnitudes for objects in an image.
The technique used here is ‘aperture photometry’, which involves positioning a circular cursor
over the object to be measured and comparing the total intensity within the aperture with the
intensity in a similar area of blank sky. There are various techniques for measuring instrumental
magnitudes, and they are discussed, along with related matters, in SC/6: The CCD Photometric
Calibration Cookbook[16]. If you are not familiar with photometric techniques then SC/6 is a
suitable place to start. The aperture photometry facilities in GAIA are provided by invoking
the PHOTOM package (see SUN/45[10]) ‘behind the scenes’, though you will just see seamless
interaction via the GAIA windows.

Before you attempt to measure instrumental magnitudes from a CCD frame any instrumental
effects, cosmic-ray events and other blemishes should already have been removed. This process
is described in SC/5: The 2-D CCD Data Reduction Cookbook[7] and in SUN/139[9], the manual
for the CCD data reduction package CCDPACK, and is not considered further here. SC/5 is a
good introduction.

The image used in this recipe is ngc1275jkt.sdf, a reduced V band CCD image of NGC 1275
obtained with the JKT (see the recipe in Section 8 for its provenance). Proceed as follows.

(1) Start GAIA and load image ngc1275jkt.sdf.

(2) You may wish to adjust the appearance of the displayed image. The most likely items to
change are the colour table (click on the Color Map: button in the lower right of the control
panel).and the magnification (click on the Scale: button in the bottom left of the control
panel in the centre top of the window)

(3) You can now proceed to measure instrumental magnitudes. Click on the Image Analysis
menu on the menu-bar along the top of the main window. Choose the Aperture photometry
item. Two further items will be presented: Results in magnitudes. . . and Results in data
counts. . . . Choose the former, Results in magnitudes. . . . (Both these options allow you to
perform aperture photometry. The former displays the results in magnitudes, the second
in counts.) An Aperture photometry – magnitudes dialogue box (see Figure 16) will be
displayed. You can drag this dialogue box off the display panel if necessary.

You should set the Frame zero point (mags) to an improbable value, typically 30, so that the
instrumental magnitudes are not inadvertently confused with calibrated ones.

Clicking the Help menu in the bar at the top of the photometry dialogue box, followed by
On Window. . . will bring up a window with a pretty comprehensive description of how to
use the aperture-photometry facilities.

The measurement process is straightforward. Following the instructions in the on-line
help, proceed as follows.

(a) Click the Define object aperture button.

(b) Place your cursor on the image over the star that you wish to measure.

(c) Press down and hold down mouse button 1.

(d) Move the mouse sideways until the circle contains all the star.

http://www.starlink.ac.uk/cgi-bin/htxserver/sc6.htx/sc6.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sc6.htx/sc6.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun45.htx/sun45.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sc5.htx/sc5.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sun139.htx/sun139.html?xref_
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(e) Release the mouse button.

(f) Click the Calculate results button.

(g) Inspect the Current object details (displayed in the upper-middle portion of the dia-
logue box) and view the instrumental magnitude of the star.

You can change things like the inner and outer radii of the annulus for measuring the sky
background by moving the sliders in the Aperture Photometry – magnitudes dialogue box.
Apertures are drawn around stars as they are measured.

Figure 16: The GAIA Aperture photometry – magnitudes dialogue box

(4) Clicking on the Options menu in the bar at the top of the Aperture photometry – magnitudes
dialogue box will allow you to alter settings by using ‘push buttons’ that are labelled:

• Use annular sky regions

• Use circular apertures
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• Keep apertures same size

By de-selecting the first button here (Use annular sky regions), you can use interactive
apertures to measure the sky background, and by de-selecting the second you can use
ellipses instead of circles. Because GAIA is acting as a ‘front-end’ to PHOTOM most of the
parameters which can be set in PHOTOM can also be set in GAIA.

There is a nice feature in GAIA that is of use when deciding how big to make the aperture
radius. By Clicking on the View menu in the main window and selecting the Slice. . . option
it is possible to obtain a ‘cut’ or ‘slice’ across any star image on-the-fly (see Figure 17). This
option can usefully be used to estimate how far out from the star useful signal exists.

Figure 17: A GAIA ‘Slice’ display panel showing a slice through an object

(5) If you click on the Parameters button in the Aperture photometry – magnitudes dialogue
box the appearance of the box changes to resemble Figure 18. You can now set various
parameters, such as the Photon data per unit, image bias level, default sky level etc.

By default the statistic used to estimate the sky background is the mean. Usually it is
preferable to use the mode because it is less affected by contamination due to faint stars.
To select the mode click on the Sky estimator: button and select the mode (see Figure 18).

(6) You should measure all the stars that you are interested in the current frame. (Click on the
Aperture button prior to resuming measuring, if necessary.) When the job is done, click
on the File menu in the menu-bar along the top of the Aperture photometry – magnitudes
dialogue box (not the one in the main GAIA window) and select Save measurements. . . to
save the results in a file of your choice. The instrumental magnitudes are listed in this file.

GAIA does not include any facilities for calibrating instrumental magnitudes into standard
photometric systems. CURSA (see SUN/190[5]) contains some simple functions for this
purpose: see SC/6[16] for an example of using them and further details.

http://www.starlink.ac.uk/cgi-bin/htxserver/sun190.htx/sun190.html?xref_
http://www.starlink.ac.uk/cgi-bin/htxserver/sc6.htx/sc6.html?xref_
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Figure 18: The GAIA Aperture photometry – magnitudes dialogue box with the options
to set parameters selected
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